To Users of

Roland VersaWorks Dual

RIP & PRINT MANAGEMENT SOFTWARE

Points for Outputting Data to a GR-640/540/420

Thank you very much for purchasing this product.

- To ensure correct and safe usage with a full understanding of this product’s performance, please be sure to read through this manual completely and store it in a safe location.
- Unauthorized copying or transferal, in whole or in part, of this manual is prohibited.
- The specifications of this product and the contents of this operation manual are subject to change without notice.
- The operation manual and the product have been prepared and tested as much as possible. If you find any misprints or errors, please inform us.
- Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage that may occur through use of this product, regardless of any failure to perform on the part of this product.
- Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage that may occur with respect to any article made using this product.
Roland DG Corp. has licensed the MMP technology from the TPL Group.
# Contents

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>2</td>
</tr>
<tr>
<td>About the Contents of This Manual</td>
<td>2</td>
</tr>
<tr>
<td>About VersaWorks Dual Help (Electronic-format Manual)</td>
<td>2</td>
</tr>
<tr>
<td>Before Connecting the GR-640/540/420</td>
<td>3</td>
</tr>
<tr>
<td>Connecting the GR-640/540/420</td>
<td>6</td>
</tr>
<tr>
<td>USB Connection</td>
<td>6</td>
</tr>
<tr>
<td>Ethernet Connection (TCP/IP Connection)</td>
<td>8</td>
</tr>
<tr>
<td>Creating Cutting Data</td>
<td>10</td>
</tr>
<tr>
<td>Adobe Illustrator CC 2017</td>
<td>10</td>
</tr>
<tr>
<td>CorelDRAW 2017</td>
<td>11</td>
</tr>
<tr>
<td>Preparations for Cutting</td>
<td>12</td>
</tr>
<tr>
<td>Cutting after Printing</td>
<td>13</td>
</tr>
</tbody>
</table>

Copyrights and property of this software and this manual belong to Roland DG Corp. No part of this software or publication may be reproduced, stored in a retrieval system, or transmitted, in any from or by any means, electronic, mechanical, photocopy, recording or otherwise, without the prior written permission of the publisher.

VersaWorks Dual is a registered trademark of Roland DG Corp.

Windows® is a registered trademark or trademark of Microsoft® Corporation in the United States and/or other countries.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone trademarks are the property of Pantone LLC. ©Pantone LLC, 2012.

Pantone is the copyright owner of color data and/or software that have been licensed to Roland DG Corp. to distribute for use only in combination with Roland VersaWorks Dual. PANTONE color data and/or software shall not be copied onto another disk or into memory unless as part of the execution of Roland VersaWorks Dual.

Other company names and product names are trademarks or registered trademarks of their respective holders.

http://www.rolanndg.com/

Copyright © 2017 Roland DG Corporation
Introduction

About the Contents of This Manual

This manual contains the basic operation methods for using Roland VersaWorks Dual (hereinafter referred to as VersaWorks Dual) to perform cutting with a GR-640/540/420. VersaWorks Dual is not included with this product. The explanations in this manual assume that you own a Roland DG printer and that VersaWorks Dual has already been installed.

About VersaWorks Dual Help (Electronic-format Manual)

The operation method of VersaWorks Dual is written in this manual. The VersaWorks Dual help is an instruction manual that you can view from the computer screen. The help can be viewed once the software is installed.

To display the help, perform the following operations.

_start VersaWorks Dual, click the [Help] menu, and then click [Display Help]._

Windows 10, 7
From the [Start] menu, click [All apps (or All Programs)] - [Roland VersaWorks Dual] - [Roland VersaWorks Dual Help].

Windows 8.1
Check to make sure that you’re using the latest version of VersaWorks Dual. If VersaWorks Dual is not the latest version, it may not be possible to perform cutting from the connected GR-640/540/420.

To perform this operation, connect the computer where VersaWorks Dual is installed to the Internet.

- If upgrading cannot be accomplished by following the steps described below, contact your authorized Roland DG Corp. dealer.

Procedure

1. Start the VersaWorks Dual update program.
   - Windows 10, 7
     1. From the [Start] menu, click [All apps (or All Programs)].
     2. Click [Roland VersaWorks Dual] - [Online Update].
     3. When the [User Account Control] window appears, click [Yes] (or [Allow]).
   - Windows 8.1
     1. Click on the [Start] screen.

2. Click [Preferences] from the [Settings] menu.
Before Connecting the GR-640/540/420

3 Make the settings for "Preferences."
   ① To use a proxy server, select the check box and type in the IP address and port number.
   ② Select the two check boxes, and then select "All Available updates."
   ③ Click [OK].

4 Click [Check for updates].

5 If the following window is displayed, click [OK].

You're using the latest version of Roland VersaWorks Dual.
If the following window is displayed, update the software.

1. **Select all of the check boxes that are available for selection.**
2. **Click [Update].**
   
The update data is downloaded.

6. **Click [OK].**
   
   When the [User Account Control] window appears, click [Yes] (or [Allow]).

7. **Click [OK].**

This completes the update of VersaWorks Dual to the latest version.
Connecting the GR-640/540/420

USB Connection

This section explains how to use a USB cable to connect the GR-640/540/420.

Procedure

1. Install the Windows-based driver for the GR-640/540/420, and then connect the GR-640/540/420 and the computer using a USB cable.
   For information on how to perform installation, see the GR-640/540/420 startup page (http://startup.rolanddg.com/).

2. Check that the GR-640/540/420 is turned on.


   Windows 10, 7
   ① From the [Start] menu, click [All apps (or All Programs)].
   ② Click [Roland VersaWorks Dual] - [Roland VersaWorks Dual].

   Windows 8.1
   ① Click on the [Start] screen.
   ② On the [Apps] screen, click [Roland VersaWorks Dual] - [Roland VersaWorks Dual].

The [Printer Settings] window appears. It appears only when starting up for the first time.
Set the device to connect.

1. Select [Printer Driver], and then select the [Printer Name].

2. Click [Verify].
   If the connection is established correctly, information pertaining to the GR-640/540/420 such as "Model Name" and "Status" is displayed.

3. Enter a [Nick Name] for the printer.
   If you do not set a nickname, the model name is displayed.

4. Click [Apply].

5. When the message "Do you want to install the printer driver?" is displayed, click [Yes].
   This message does not indicate the printer driver to use in communication.

6. When the [User Account Control] window appears, click [Yes] (or [Allow]).

7. When the [Add Printer Wizard] window appears, click [Next].
   The connected device information appears in the [Printer List].

8. Click [OK].

This completes the preparations for cutting using VersaWorks Dual.
Connecting the GR-640/540/420

Ethernet Connection (TCP/IP Connection)

This section explains how to use an Ethernet cable to connect the printer.

Procedure

1. Perform all the preparations required for establishing an Ethernet connection, including installing the Windows-based driver. Then, connect the GR-640/540/420 and the computer using Ethernet cables.
   For information on how to configure the settings and how to perform installation, see the GR-640/540/420 startup page (http://startup.rolanddg.com/+).

2. Check that the GR-640/540/420 is turned on.

3. Connect the GR-640/540/420 and the computer (RIP server) to the network.

4. Start VersaWorks Dual.

   Windows 10, 7
   1. From the [Start] menu, click [All apps (or All Programs)].
   2. Click [Roland VersaWorks Dual] - [Roland VersaWorks Dual].

   Windows 8.1
   1. Click on the [Start] screen.

The [Printer Settings] window appears. It appears only when starting up for the first time.
Set the device to connect.

1. Select [Printer Driver], and then select the [Printer Name].

2. Click [Verify].
   If the connection is established correctly, information pertaining to the GR-640/540/420 such as "Model Name" and "Status" is displayed.

3. Enter a [Nick Name] for the printer.
   If you do not set a nickname, the model name is displayed.

4. Click [Apply].

5. When the message "Do you want to install the printer driver?" is displayed, click [Yes].
   This message does not indicate the printer driver to use in communication.

6. When the [User Account Control] window appears, click [Yes] (or [Allow]).

7. When the [Add Printer Wizard] window appears, click [Next].
   The connected printer information appear in the [Printer List].

8. Click [OK].

This completes the preparations for cutting using VersaWorks Dual.
The term "cutting data" is used to refer to data that includes cutting lines. Use illustration software (such as Adobe Illustrator) to create the cutting data. This section explains how to create cutting data using Adobe Illustrator and CorelDRAW, which are typical pieces of application software. However, this section assumes that you are already familiar with the basic operations of these pieces of application software.

Adobe Illustrator CC 2017

1. Register the spot color.

   Register in the swatch library the special color to use for cutting lines.

   1. Insert the Roland VersaWorks Dual DVD-ROM in the computer's DVD-ROM drive.
   2. Open the [SpotColorLibrary] - [Illustrator] folder on the DVD disk.
   3. Copy the [Roland VersaWorks.ai] file to the [Swatches] folder in the folder where Adobe Illustrator is installed.
      The folders under the Illustrator installation folder are composed as shown below. Presets/(language folder, example: en-US)/Swatches

2. Create the cutting data.

   Create cutting data, which includes the cutting lines.

   1. Start Adobe Illustrator, and then create the illustration data.
   2. Click the [Window] menu - [Swatch Libraries] - [Roland VersaWorks].
      The [Roland VersaWorks] swatch library is displayed.
   3. Select only the path that you want to make into a cutting line, and then select [line] in the tool palette.
Creating Cutting Data

4 Select the swatch named [CutContour] in the swatch library. The color of the specified path changes to [CutContour].

5 Save the data in EPS or PDF format.

CorelDRAW 2017

1. Register the spot color.
   Spot colors used for cutting lines are included in CorelDRAW 2017, so there is no need to register the spot color.

2. Create the cutting data.
   Create cutting data, which includes the cutting lines.

   1 Start CorelDRAW, and then create the illustration data.
   2 On the [Window] menu, click [Color Palettes] - [Color Palette Manager].
   3 In the Color Palette Manager, click [Palette Libraries] - [Spot] - [Roland], and then click the [show/hide] icon next to [Roland VersaWorks]. The [Roland VersaWorks] palette is displayed on the screen.
   4 Select only the path that you want to make into a cutting line, and then click [CutContour] in the [Roland VersaWorks] palette.
   5 Click [File] - [Export] to save the file in EPS or PDF format.
Preparations for Cutting

1. **Determine the cutting conditions.**

   For the cutting conditions, you have to set appropriate values for each type of material. When you are cutting a material that you have never used before, use a piece of the material to determine the cutting conditions in advance.

   1. **Operate the GR-640/540/420 to perform a cutting test.**
      
      See "Performing a Cutting Test" under "Optimizing the Cutting Quality for the Material" under "Improving the Finish" in the basic operation edition of the GR-640/540/420 user's manual.

   2. **View the results of the cutting test, and then change the cutting conditions.**
      
      - Cutting force (pressure during cutting)
      - Cutting speed (speed during cutting)
      - Cutting-in amount (amount of blade extension)

      For details on how to change the settings, see the linked items in "Optimizing the Cutting Quality for the Material" under "Improving the Finish" in the basic operation edition of the GR-640/540/420 user's manual.

   3. **Change the conditions, and then perform a cutting test again.**

   4. **Repeat steps 2 and 3 until the cutting conditions are optimized.**

   5. **Save the set conditions.**

      For the operation method, see "Saving the Cutting Conditions" under "Saving and Reusing Conditions after Adjusting the Cutting Quality" under "Other Things You Can Do" in the application edition of the GR-640/540/420 user's manual.

2. **Change the GR-640/540/420 coordinate system.**

   Match the coordinate systems on the printer and on the cutting machine. Set the coordinate system when you are performing printing followed by cutting from VersaWorks Dual. If you are only performing normal cutting, return the coordinate system to 0 degrees.

   1. **Rotate the direction of the coordinate axis by 90 degrees.**
      
      See "Setting the Direction of the Coordinate Axis for Cutting (ROTATE)" under "Reducing Wasted Material" under "Other Things You Can Do" in the application edition of the GR-640/540/420 user's manual.
This section explains how to use the GR-640/540/420 to cut material that has been printed with a printer. Flatbed-type UV printers do not support printing followed by cutting.

1. Print with crop marks.

Add the crop marks for aligning the positions, and then perform just printing.

**IMPORTANT: Ensure there is a margin of 15 mm (0.59 in.) or more from the edge of the material.**

When you are printing with a printer, set the margin from the edge of the material to 15 mm (0.59 in.) or more. If the margin is smaller than 15 mm (0.59 in.), the GR-640/540/420 may not be able to read the crop marks normally.

1. Double-click or .

   The [Queue A (B) Properties] window appears.

2. Click .

3. Select the [Crop Marks (Print&Cut Alignment)] check box.

4. Click .

5. Select [Print Only] from the [Operation Mode] list box.

6. Click [OK].

**IMPORTANT**

If the source data for the job is an EPS file and a cutting line has been drawn around the border, configure the settings shown below before adding the job to the job list. If you do not configure these settings, a part of the border may not be cut.


2. Enter a value of 0.35 mm (13.8 mil) or more for [Margin] under [EPS].
   - If you enter a value less than 0.35 mm (13.8 mil), no margin will be added.
   - If you configure the zoom in/zoom out settings on the [Queue Properties] or [Job Settings] window, the margin will also be zoomed in on/zoomed out from. When you add a job to the job list, a margin with the width set with [Margin] is automatically added within the range specified by the border.

7. Click [File] - [Add Job to Queue A] (or [Add Job to Queue B]).

   The [Load from File] window is displayed.

8. Select the cutting data to add to the job list, and then click [Open].

   The selected data is displayed in the job list. Select the data that includes the cutting lines (paths specified with CutContour).

9. Select the job to print from the job list, and then click [Print].

   The job is printed with crop marks.
**Cutting after Printing**

### 2. Cut the printed material.

Load the printed material into the GR-640/540/420, and then perform cutting.

1. **Perform laminating or other required processing, and then load the material into the GR-640/540/420.**
   
   See "Step 5: Load the Printed Material" under "Procedures for Printing Followed by Cutting" under "Printing Followed by Cutting" in the application edition of the GR-640/540/420 user's manual. There are three types of procedures in "Procedures for Printing Followed by Cutting," but you can see any of these procedures.

2. **Display the [Job Settings] window.**
   
   ① Select a job that has been printed, and then drag it to the job list (queue A (or B) folder) of the GR-640/540/420.

![Job Settings Window](image)

   ② Select the job that you have dragged, and then double-click it.

3. **As necessary, perform the operations shown below.**

   **Cut the border of the job regardless of whether a cutting line is present.**
   
   - Select the [Cut Image Boundaries] check box.

   **When cutting is finished, return the media to the origin prior to cutting.**
   
   - Select the [Return to Origin After Cut] check box.

   **Set printer cutting conditions such as the blade force.**
   
   - Select the [Enable Advanced Settings] check box to enable the settings.

4. **Click [OK].**

5. **Select the job to cut from the job list.**

6. **Click [ ]**.

   The machine reads the crop marks to align the positions, and then cuts the material.